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MapInfo Universal 
Translator User Guide
The MapInfo Universal Translator translates files in MapInfo formats to several 
different spatial data formats and translates files from several formats into 
MapInfo .TAB files. The Universal Translator is typically run as a tool under 
MapInfo Professional's Tools Menu, but can also be run manually in a 
MapBasic window, using another language program, or in batch-file mode. This 
User Guide describes both processes in detail.

Note For using other data with universal formats such as ESRI ArcSDE, 
ESRI Personal Geodatabase (*.MDB), USGS Spatial Data Transfer 
Standard (*.CATD.DDF), VPF NIMA/NGA (*.FT), try the Universal 
Data option in MapInfo Professional.
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Using the Translator from within MapInfo Professional
Introduction to the MapInfo Universal Translator
The Universal Translator can translate these file formats into MapInfo .TAB and .MIF\.MID files: 

• AutoCAD DWG/DXF 
• ESRI ArcInfo Export (E00) 
• ESRI Shapefile (SHP)
• MicroStation Design (DGN)
• Spatial Data Transfer Standard (SDTS) 
• Vector Product Format (VPF)

The Universal Translator can translate MapInfo .TAB and .MIF\.MID files into these formats: 

• AutoCAD DWG/DXF 
• ESRI ArcInfo Export (E00) 
• ESRI Shapefile 
• MicroStation Design 

Using the Translator from within MapInfo Professional
If you are working in MapInfo Professional you can use the Universal Translator to convert files from 
its existing format into a MapInfo .TAB file or .MIF/.MID file or from .TAB file format into other vector 
formats.

Loading the Universal Translator into the Tool Manager
The Universal Translator is automatically loaded with MapInfo Professional. It is accessed by 
choosing Tools > Universal Translator > Universal Translator. If unloaded, then you must reload 
it manually from the Tools menu.

To load the Universal Translator to the Tool Manager menu:

1. From the MapInfo Professional Main menu choose Tools > Tool Manager. The Tool Manager 
dialog box displays.
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2. Scroll down the Tools list and do one of the following:
• If the Universal Translator is not in the list, go to step 3.
• If the Universal Translator is in the list, scroll down to the entry and go to step 7.

3. Click the Add Tool button and the Add Tool dialog box displays.

4. Type Universal Translator into the Description field.

5. Beside the Location field, click the  button. Using the Select MapBasic Program dialog box, 
search for the MUT.MBX file in the \UT folder within your installation directory. When you find it, 
select it and click Open.

6. Click OK to add the Universal Translator to the Tool Manager window.
7. To load the Universal Translator for this session only, select the check box in the Load column. 

To load the Universal Translator each time you open MapInfo Professional, select the AutoLoad 
check box. Both check boxes can be selected.

8. Click OK to save your entries.
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Using the Translator from within MapInfo Professional
Using the Universal Translator
To run the Universal Translator:

1. Choose Tools > Universal Translator > Universal Translator to display the Universal 
Translator dialog box.

2. In the Source box, use the Format drop-down list to display a list of formats and select the 
source format for the dataset that you want to translate.
When the format of the input dataset is MicroStation Design, the Settings button enables. Click 
this button to display the Design File Input Settings dialog box. Choose the appropriate 
coordinate units.

3. Type the name(s) of the files you want to translate or select  to search for the source files and 
click Open to return to the Universal Translator dialog box.

Note When you select AutoCAD, the translator defaults to DWG format.

If you select AutoCAD files, ArcInfo files, Shapefiles, MicroStation Design files, or Vector Product 
Format files from the Format drop-down list, the Projection button enables. Use this button to 
display the Choose Projection list and set a specific projection for the input file. 
The projection files that display in the Choose Projection list are from the MapInfo Projection 
MAPINFOW.PRJ file. If the appropriate projection entry does not display in this list, you can 
make a custom matching projection entry beforehand in this file (see the MapInfo Professional 
User Guide for more detail). If you select the wrong projection, you may get erroneous results. 
Please contact the vendor or original creator of this data to obtain descriptive 
information\metadata concerning the projection\coordinate system used in the input files to 
translate them correctly into MapInfo format.

Note An additional Use Projection setting in source file check box displays when you select 
Shapefiles as a source. When you select this check box, the Translator looks for the 
projection setting in a *.prj file, if it exists in same directory as SHP file, projection file and 
uses it for the translation if its a supported projection in MapInfo Professional.
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4. In the Destination box, select the format into which you would like to translate the selected 
file(s) in the Format drop-down list.
• If you select the ArcInfo format, a Settings button displays. Click this button to select 

Coverage Precision and Compression options for the translated file.
• If you select a MicroStation Design format, you can select the version number for the 

translated file you are creating.

Note When translating a file into a MapInfo .TAB file, the translation creates table versions 
unique to the MapInfo Professional version capable of using the data contained in the 
TAB file.

5. In the Directory field, enter the destination of the translated file(s) or click  to indicate the 
name and path of the destination. 

Note If the source file is MapInfo .TAB format, and the destination file is AutoCAD, a Settings 
button displays. Click to display the AutoCAD Output Settings dialog box and select the 
appropriate AutoCAD file version from the list. In this case, you also select the whether 
the output should be DWG or DXF.

6. Set up the log file. The Universal Translator automatically creates a log file to document the 
translation process. If the translation fails, you should first look at the log to determine the cause 
of failure. 
a. Enter a name and location for this log file in the Log to File field. The default is your current 

temp directory and a file name of mutlog.txt (C:\temp\mutlog.txt). You can also select the  
button to choose another name and/or path for this log file.

b. To add to an existing log file, select the Append to Log check box. This adds the log entries 
from the translation to the end of the previous log entry. When you do not select this check 
box, the Universal Translator overwrites the previous log entries. This step is not required.

Note To view the existing log, click View Log.

7. Click OK to begin the translation process.

For more information about the Universal Translator dialog box, see Understanding the Universal 
Translator Dialog Box in the next section. There is more detail in the Universal Translator Help 
System about the other dialog boxes discussed in this section. Use these descriptions to guide you 
through the intricacies of the translation process. Press the F1 Help key on your keyboard to display 
help for the active Universal Translator dialog box.

Understanding the Universal Translator Dialog Box
The fields in the Universal Translator dialog box are described more fully in this section.

Source Format

Use the Format drop-down list to display a list of formats.  Select the Source Format for the dataset 
that you want to translate. When the format of the input dataset is MicroStation Design, the Settings 
button is enabled.  Click this button to display the Design File Input Settings dialog box. Choose the 
appropriate co-ordinate units:

• Master
• Sub
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• UOR

File(s)

Enter the file(s) to be translated or click  to display the Select Input Files dialog box. Choose the 
file(s) from the Select Input dialog box. When you select AutoCAD, the system defaults to DWG 
format.

Use projection setting in source file
This option is available when you select the Shapefile format.  Select this check box to have the 
Universal Translator look automatically for a matching MapInfo Professional projection from the 
Shapefile's associated *.prj file, if one exists in the same directory, and create the .TAB/.MIF file in 
that projection.  You can make a custom matching projection entry beforehand in the 
MAPINFOW.PRJ file if one does not exist, (see the MapInfo Professional User Guide for more 
detail).

If you do not select this check box, the .TAB/.MIF file is created in a Non-Earth, meters system by 
default, or another projection by clicking on the Projection button and selecting the correct 
projection to apply to the translated .TAB or .MIF/.MID file.

Projection button
Available when you have selected a AutoCAD DWG/DXF, ESRI ArcInfo Export (E00), ESRI 
Shapefile (SHP), MicroStation Design (DGN), or Vector Product Format (VPF) format. Displays the 
Choose Projection dialog box.  Select the correct projection to apply to the translated .TAB or 
.MIF/.MID file.

If you have selected a MapInfo .TAB, .MIF\.MID, or SDTS format file, "Read from Source" displays 
since these files contain coordinate system information. If you have selected Shapefile, AutoCAD, 
Intergraph, or VPF files, designate the coordinate system; if you do not designate a coordinate 
system, the Universal Translator defaults to Non-Earth, meters.

Note If you designate the wrong coordinate system, errors may occur or data will be translated to 
incorrect location or not at all.  The Universal Translator does not convert coordinates from 
one projection to another, so make sure the chosen projection matches the one intended for 
the data. This projection information is often stored in metadata with the source files or 
obtained from its authors.

Please contact the vendor or original creator of this data to obtain descriptive information\metadata 
concerning the projection\coordinate system used in the input files to translate them correctly into 
MapInfo format.

Choose  to display the Choose Projection dialog box.

Category
Choose a projection from the Category drop-down list.

Category Members
Choose the appropriate coordinate unit from the Category Members drop-down list.
8 Universal Translator



Chapter 1: MapInfo Universal Translator User Guide
Destination Format
Select the format of the translated file.

Note When translating into MapInfo .TAB, the translation creates MapInfo tables in the version 
capable of opening and using the features or attribute data contained in that table after 
translation, such as newer projections or Date\Time data.

Directory

Enter the destination of the translated file or click  to display the Select Directory dialog box and 
designate the name and path of the destination file. 

If the source file is MapInfo format, and the destination file is AutoCAD, a Settings button displays. 
Click this button to display the AutoCAD Output Settings dialog box and select the appropriate 
version of AutoCAD.

Log 
The Universal Translator automatically creates a log file documenting the translation process.  
Should the translation fail, you should first look at the log to determine the cause of failure.

Log to File
Specify a filename and location for the Log file. The default mutlog.txt log file location is the user's 

temporary file directory specified by the Windows System. Click  to designate another name/path 
for the log file.

Append to Log
When you select this button, the log entries resulting from the next translation append to the 
previous one. When this button is cleared, a new log is created, overwriting the previous log entries.

Some Notes About Using the Universal Translator
• To produce successful results, the data you are converting must be in the language of the 

system you are using
• This version is double-byte enabled; contains support for the latest Shape file format; updated 

AutoCAD metafiles and updated Intergraph metafiles
• The Universal Translator does not officially support 3-dimensional Intergraph DGN or 3 

dimensional AutoCAD DWG/DXF files; the translation results using these files are unpredictable
• Unlike MapInfo Professional's import DXF, the Universal Translator does not perform coordinate 

transformations
• When translating DWG/DXF to .TAB/.MIF, the Universal Translator does not translate AutoCAD 

meshes
• When translating DWG/DXF or DGN, the translator does not attempt to match display attributes, 

including line color, font type.
• Universal Translator does support UNC paths
• When translating from Shapefiles to .TAB files, the Universal Translator defaults empty fields to 

the following:
a. Empty numeric field with a width of one translates to a 0 (zero)
b. Empty numeric field with a width of two translates to -9
c. Empty numeric field with a width of three translates to -99
d. Empty numeric field with a width of four translates to -999
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e. Empty numeric field with a width of five or greater translates to -9999

A single file translation may result in multiple files depending on file types.

Virtual Memory:  When translating to or from DWG/DXF, it is possible to encounter a lack of virtual 
memory. An error message displays indicating this problem.

Using the Universal Translator From the Command Line
Below are the syntax and parameter descriptions for running Universal Translator in this command-
line mode. Only the parameters that are supported and tested by Pitney Bowes Business Insight are 
included in the descriptions below. Any other command-line parameters not listed are unsupported, 
and assistance with these should be obtained from SAFE Software, Inc. The Universal Translator 
uses syntax from Full FME translator but SAFE Software. The commands used in the examples 
below expose the same functionality that is obtained via the Universal Translator GUI provided with 
MapInfo Professional. Examples of its use in MapBasic programming language are also provided if 
you need them. 

In all the examples provided, the path names are to be replaced by something actually present on a 
user system. In addition, each place where MAPINFO is present in the command line can be 
replaced by .MIF if .MIF files are required instead of native .TAB files. 

The command line examples also assume a DOS prompt that is running from the directory holding 
the IMUT.exe executable. In addition, all the parameters should be placed in one continuous line for 
each command to be executed. 

Translations are performed in two stages. The application: 

1. Generates a semantic control or mapping file script that controls the translation. 
2. Runs the translation using this generated mapping file. 

Important syntax notes:

• Any options given as Yes can also be specified as No to turn off the behavior. 
• The DestDataset indicates where the output is to be written, and the SourceDataset controls 

where the input is read from. 
• Log files can be generated from each stage.
• Embedded quotes such as MapInfo CoordSys clauses need to be passed with escape 

characters such as this example: 
CoordSys Earth Projection 10, 104, \"m\", 0** In MapBasic, a CoordSys 
string containing a specific map unit can be passed like this to 
IMUT:"CoordSys Earth Projection 10, 104," + chr$(92) + chr$(34) + "m" + 
chr$(92)+ chr$(34)+ ", 0"** Uses ASCII character codes chr$(92) for the 
“\” character and chr$(34) to embed quoted strings.
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Importing Data Using the Command Line
This section provides details for importing data into MapInfo Professional from other data source 
formats. 

Note Important: In this document we only cover the features that are used in MapInfo 
Professional’s Universal Translator MBX. If you use command line parameters other than 
those documented here, Pitney Bowes Business Insight Corporation has not tested and does 
not support them. Support for those command-line parameters and for any unexpected 
results that occur need to be obtained from SAFE Software, Inc. 

Importing Data from AutoCAD DWG and DXF Formats 
Follow these steps to import data from AutoCAD DWG and DXF formats into a MapInfo .TAB file 
from the command line.

Step 1) Generating the Mapping File

Imut.exe CFGenerate autocadScan MAPINFO "D:\test.dwg" "C:\Temp\mapping.fme" 
LOG_STANDARDOUT YES LOG_FILENAME "C:\Temp\mutlog.txt” LOG_APPEND “NO” --
Source_EXPAND_BLOCKS "yes" --Source_ATTR "autocad_attributes" --Source_ATTRKIND 
"extended_entity_data" --LAYERBASENAME "test" 

Understanding the Mapping File Parameters

Imut.exe – Application name of the MapInfo Universal Translator. Assumes it is running from the 
DOS prompt, so path to it should be set.

CFGenerate – Command that generates a semantic control file

autocadScan – Input format is AutoCAD format file.

MAPINFO – Output format is MapInfo .TAB. If the output file format is .MIF\.MID, then use “.MIF”.

"D:\test.dwg" – Path and filename of the input AutoCAD file.

"C:\Temp\mapping.fme" – Path and filename of the semantic control file – can be prefixed with any 
name.

LOG_STANDARDOUT – Generates a text log file during the translation (Yes or No).

LOG_FILENAME – Path and filename of the logfile to be generated. 

LOG_APPEND – Appends the results of logfiles in subsequent translations – (Yes or No) – Default 
is No. 

• Source_EXPAND_BLOCKS – By default the Universal Translator expands blocks in AutoCAD 
files (Yes or No) – Default is Yes. 

• Source_ATTR – "autocad_attributes" – handles AutoCAD attributes 
• Source_ATTRKIND – "extended_entity_data" – handles extended entities in AutoCAD files. 
• LAYERBASENAME – Optional prefix added to all resulting .TAB filenames. 

Note **The LAYERBASENAME argument is a prefix which is added to all resulting MapInfo table 
names, and is optional. Typically it is the root name of the source DWG file. 
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Step 2) Running the Mapping File to Perform the Translation

Imut.exe "C:\Temp\mapping.fme" --SourceDataset “D:\test.dwg” --DestDataset “C:\output” --
_EXPAND_BLOCKS yes --_ATTRKIND extended_entity_data --_EXTENSION dwg --_BASENAME 
test --_FULLBASENAME test MAPINFO_COORDSYS_STATEMENT “CoordSys Earth Projection 
10, 104, \"m\", 0” 

Understanding the Translation Parameters

Imut.exe – Name of the MapInfo Universal Translator executable. 

"C:\Temp\mapping.fme" – Path and filename of the semantic control file generated in step 1. 

• SourceDataset “D:\test.dwg” – Path and filename of the input file to be translated. 
• DestDataset “C:\output” – Path and folder name of the output to be generated. 
• _EXPAND_BLOCKS – Same as --Source_EXPAND_BLOCKS above – (Yes or No). 
• _ATTRKIND – Same as --Source_ATTRKIND above – (extended_entity_data ). 
• _EXTENSION – Input format extension (DWG or DXF are valid AutoCAD format extensions) – 

Case insensitive. 
• _BASENAME – Name of output file to be generated – can be same as LAYERBASENAME. 
• _FULLBASENAME – Can be same as LAYERBASENAME 

MAPINFO_COORDSYS_STATEMENT – Optional parameter – The CoordSys Clause applied to 
result TAB\MIF\MID file.  IMUT will not re-project data being translated into a different coordinate 
system\projection, it applies the CoordSys clause passed to the result TAB\MIF file. Make sure the 
CoordSys used is appropriate for the data being translated. The output TAB\MIF file will default to 
the projection specified in the Shape file’s *.prj file (if it exists in same directory) or to Non-
Earth/meters if no CoordSys clause is passed and no .SHP file *.prj file exists.

Importing Data from the MicroStation DGN Format

Step 1) Generating the Mapping File

Imut.exe Generate design .MIF "C:\test.dgn" "C:\Temp\mapping.fme" LOG_STANDARDOUT YES -
-Source_IGDS_MSLINKS "no" --Source_XPNDCELL "yes" --Source_PRESERVE_CELL_INSERTS 
"no" --SourceSPLIT_MULTITEXT "yes" --Source_PROPAGATE "no" --Source_DROP_COMPLEX 
"no" --Source_TEXTTAGS "yes" --Source_IN_UNITS "IGDS_MASTER_UNITS" --
Source_USE_LEVEL_NAMES "no" +MERGE_SCHEMAS YES 

Understanding the Mapping File Parameters

Imut.exe – Application name of the MapInfo Universal Translator. Assumes it is running from a DOS 
prompt, so path to it should be set.

Generate – Universal Translator command that generates a semantic control file.

design – Input format set to MicroStation.

DGNMAPINFO – Output format set to MapInfo .TAB. If .MIF\.MID output needed, then use ".MIF".

"C:\test.dgn" – Path and filename of input MicroStation DGN file.

"C:\Temp\mapping.fme" – Path and name of the semantic mapping\control file.
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LOG_STANDARDOUT – Output a text logfile of translation (Yes or No) – use with LOG_FILENAME 
parameter to create the file.

LOG_FILENAME – Path and filename of the logfile to be generated.

LOG_APPEND – Appends the results of logfiles in subsequent translations – (Yes or No) – Default 
is No. 

• Source_IGDS_MSLINKS – Supports MSLINKS in DGN files (Yes or No). 
• Source_XPNDCELL – Expands Cell Elements (Yes or No) 
• Source_PRESERVE_CELL_INSERTS – Preserves cell insert points (Yes or No) – if Cell 

Elements are expanded only. 
• SourceSPLIT_MULTITEXT – Splits multi Text (Yes or No) – Default is Yes. 
• Source_PROPAGATE – Propagates the chain member linkages (Yes or No) – applied when not 

dropping complex elements. 
• Source_DROP_COMPLEX – Drops complex chains while reading (Yes or No) – Default is No. 
• Source_TEXTTAGS – Tags elements output as text when reading source file (Yes or No) -

Default is Yes. 
• Source_IN_UNITS – Controls how all the FME coordinates read from the design file are 

interpreted. 

Valid values are: 

IGDS_MASTER_UNITS – FME coordinates are treated as Master Units – DEFAULT.

IGDS_SUB_UNITS – FME coordinates are treated as Sub Units.

IGDS_UORS – FME coordinates are treated as UORs.

Step 2) Running the Mapping File to Perform the Translation

Imut.exe C:\Temp\mapping.fme --SourceDataset “C:\test.dgn” --DestDataset “C:\output” --
_XPNDCELL yes --_IN_UNITS IGDS_MASTER_UNITS --_EXTENSION dgn --_BASENAME 
filename --_FULLBASENAME filename MAPINFO_COORDSYS_STATEMENT "CoordSys Earth 
Projection 11, 104, \"m\", 0" 

Understanding the Translation Parameters

Imut.exe – Name of the MapInfo Universal Translator executable.

"C:\Temp\mapping.fme" – Path and filename of the semantic control file generated in step 1.

• SourceDataset “D:\test.dgn” – Path and filename of the input file to be translated. 
• DestDataset “C:\output” – Path and folder name of the output to be generated. 
• _XPNDCELL – Same as --Source_XPNDCELL parameter in Step 1. (Yes or No). 
• _IN_UNITS – Same as --Source_IN_UNITS parameter in step 1. (Default is 

IGDS_MASTER_UNITS).
• _EXTENSION – Format extension of the input file (DGN) 
• _BASENAME – Name of the output file to be generated – can be same as LAYERBASENAME. 
• _FULLBASENAME – Can be same as LAYERBASENAME
• MAPINFO_COORDSYS_STATEMENT – Optional parameter – The CoordSys Clause applied to 

the resulting .TAB\.MIF\.MID file. The Universal Translator does not re-project data being 
translated into a different coordinate system\projection, it applies the CoordSys clause passed to 
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the resulting .TAB\.MIF file, so make sure the coordinate system you use is appropriate for the 
data being translated. If no CoordSys clause is passed, the output .TAB\.MIF file defaults to Non-
Earth, meters. 

Importing Data from the E00 Format

Step 1) Generating the Mapping File

Imut.exe CFGenerate E00 MAPINFO "C:\temp\polygon.e00" "C:\Temp\mapping.fme" 
LOG_STANDARDOUT YES LOG_FILENAME "C:\Temp\mutlog.txt" LOG_APPEND "NO" 

Understanding the Mapping File Parameters

Imut.exe – Application name of the MapInfo Universal Translator. Assumes it is running from DOS 
prompt, so path to it should be set.

CFGenerate – Command that generates a semantic control file

E00 – Input format set to ArcInfo Export Format

MAPINFO – Output format set to MapInfo .TAB. If .MIF\.MID output is needed, then use ".MIF".

"C:\temp\polygon.e00" – Path and filename of the input ArcInfo .E00 file.

"C:\Temp\mapping.fme" – Path and name of the semantic mapping\control file.

LOG_STANDARDOUT – Outputs a text logfile of translation (Yes or No) – use with 
LOG_FILENAME parameter to create a file.

LOG_FILENAME – Path and filename of the logfile to be generated.

LOG_APPEND – Appends the results of logfiles in subsequent translations – (Yes or No) – Default 
is No. 

Step 2) Running the Mapping File to Perform the Translation

Imut.exe “C:\Temp\mapping.fme” --SourceDataset "C:\temp\polygon.e00" --DestDataset “C:\temp” -
-_EXTENSION e00 --_BASENAME polygon --_FULLBASENAME polygon 
MAPINFO_COORDSYS_STATEMENT "CoordSys Earth Projection 1, 104" 

Understanding the Translation Parameters

Imut.exe – Name of the MapInfo Universal Translator executable.

"C:\Temp\mapping.fme" – Path and filename of the semantic control file generated in step 1.

• SourceDataset “c:\temp\polygon. e00” – Path and filename of the input file to be translated. 
• DestDataset “C:\temp” – Path and folder name of the output to be generated. 
• _EXTENSION – Format extension of the input file (.E00) 
• _BASENAME – Name of the output file to be generated – can be same as LAYERBASENAME. 
• _FULLBASENAME – Can be same as LAYERBASENAME

MAPINFO_COORDSYS_STATEMENT – Optional parameter – The CoordSys Clause applied to 
the resulting .TAB\.MIF\.MID file. The Universal Translator does not re-project data being 
translated into a different coordinate system\projection. It applies the CoordSys clause passed to 
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the resulting .TAB\.MIF file, so make sure the CoordSys used is appropriate for the data being 
translated. If no CoordSys clause is passed, the output .TAB\.MIF file defaults to Non-Earth, 
meters. 

Importing Data from the Shapefile Format

Step 1) Generating the Mapping File

Imut.exe CFGenerate SHAPE MAPINFO "C:\temp\poly.shp" "C:\Temp\mapping.fme" 
LOG_STANDARDOUT YES LOG_FILENAME "C:\Temp\mutlog.txt" LOG_APPEND "NO" 

Understanding the Mapping File Parameters

Imut.exe – Application name of the MapInfo Universal Translator. Assumes it is running from a DOS 
prompt, so path to it should be set.

CFGenerate – Command that generates a semantic control file

SHAPE – Input format set to ESRI Shapefile format.

MAPINFO – Output format set to MapInfo .TAB. If .MIF\.MID output needed, then use ".MIF".

"C:\temp\poly.shp" – Path and filename of the input ESRI Shapefile.

"C:\temp\mapping.fme" – Path and name of the semantic mapping\control file.

LOG_STANDARDOUT – Outputs a text logfile of translation (Yes or No) – use with 
LOG_FILENAME parameter to create the file.

LOG_FILENAME – Path and filename of the logfile to be generated.

LOG_APPEND – Appends the results of the logfiles in subsequent translations – (Yes or No) – 
Default is No. 

Step 2) Running the Mapping File to Perform the Translation

Imut.exe “C:\Temp\mapping.fme” --SourceDataset “C:\temp\poly.shp” --DestDataset “C:\temp” --
_EXTENSION shp --_BASENAME filename--_FULLBASENAME filename 

Understanding the Translation Parameters

Imut.exe – Name of the MapInfo Universal Translator executable.

"C:\Temp\mapping.fme" – Path and filename of the semantic control file generated in step 1.

• SourceDataset “c:\temp\poly.shp” – Path and filename of the input file to be translated. 
• DestDataset “C:\temp” – Path and folder name of output to be generated. 
• _EXTENSION – Format extension of input file (Shapefile) 
• _BASENAME – Name of output file to be generated – can be same as LAYERBASENAME. 
• _FULLBASENAME – Can be same as LAYERBASENAME
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MAPINFO_COORDSYS_STATEMENT – Optional parameter – The CoordSys Clause applied to 
resulting .TAB\.MIF\.MID file. The Universal Translator does not re-project data being translated into 
a different coordinate system\projection. The output TAB\MIF file will default to the projection 
specified in the Shape file’s *.prj file (if it exists in same directory) or to Non-Earth/meters if no 
CoordSys clause is passed and no SHP file *.prj file exists. 

Importing Data from the SDTS Format 

Step 1) Generating the Mapping File

Imut.exe Generate SDTS MAPINFO "C:\Temp\TR01CATD.DDF" "C:\Temp\mapping.fme" 
LOG_STANDARDOUT YES LOG_FILENAME "C:\Temp\mutlog.txt" LOG_APPEND "NO" 

Understanding the Mapping File Parameters

Imut.exe – Application name of the MapInfo Universal Translator. Assumes it is running from a DOS 
prompt, so path to it should be set.

Generate – Command that generates a semantic control file

SHAPE – Input format set to Spatial Data Transfer Standard (SDTS).

MAPINFO – Output format set to MapInfo .TAB. If .MIF\.MID output is needed, then use ".MIF".

"C:\temp\TR01CATD.DDF" – Path and filename of the SDTS archive to be translated 
(****CATD.DDF).

"C:\temp\mapping.fme" – Path and name of the semantic mapping\control file.

LOG_STANDARDOUT – Outputs a text logfile of translation (Yes or No) – use with 
LOG_FILENAME parameter to pump it out to a file.

LOG_FILENAME – Path and filename of the logfile to be generated.

LOG_APPEND – Appends the results of logfiles in subsequent translations – (Yes or No) – Default 
is No.

Step 2) Running the Mapping File to Perform the Translation

Imut.exe “C:\Temp\mapping.fme” --SourceDataset “C:\Temp\TR01CATD.DDF” --DestDataset 
“C:\Temp”

Understanding the Translation Parameters

Imut.exe – Name of the MapInfo Universal Translator executable.

"C:\Temp\mapping.fme" – Path and filename of the semantic control file generated in step 1.

• SourceDataset “C:\Temp\TR01CATD.DDF” – Path and filename of the input file from SDTS 
archive to be translated. 

• DestDataset “C:\temp” – Path and folder name of the output to be generated.

**MAPINFO_COORDSYS_STATEMENT is not used, the CoordSys is read directly from input SDTS 
file. 
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Importing Data from the VPF Format 

Step 1) Generating the Mapping File

Imut.exe Generate VPF MAPINFO "C:\input\NAV" "C:\Temp\mapping.fme" LOG_STANDARDOUT 
YES LOG_FILENAME "C:\Temp\Mutlog.txt" LOG_APPEND "NO" +ID "BUOYBCNP" 

Understanding the Mapping File Parameters

Imut.exe – Application name of the MapInfo Universal Translator. Assumes it is running from DOS 
prompt, so the path to it should be set.

Generate – Command that generates a semantic control file

VPF – Input format set to Vector Product format (VPF).

MAPINFO – Output format set to MapInfo .TAB. If .MIF\.MID output is needed, then use ".MIF"

"C:\input\NAV" – Path and folder of the VPF archive to be translated.

"C:\temp\mapping.fme" – Path and name of the semantic mapping\control file.

LOG_STANDARDOUT – Outputs a text logfile of translation (Yes or No) – use with 
LOG_FILENAME parameter to create a file.

LOG_FILENAME – Path and filename of the logfile to be generated.

LOG_APPEND – Appends the results of logfiles in subsequent translations – (Yes or No) – Default 
is No.

+ID "BUOYBCNP" – Layer Name (ID) of the VPF archive to be translated.

Step 2) Running the Mapping File to Perform the Translation

Imut.exe “C:\Temp\mapping.fme” --SourceDataset “C:\input\NAV” --DestDataset “C:\output” 
MAPINFO_COORDSYS_STATEMENT "CoordSys Earth Projection 1, 104"

Understanding the Translation Parameters

Imut.exe – Name of the MapInfo Universal Translator executable.

"C:\Temp\mapping.fme" – Path and filename of the semantic control file generated in step 1.

• SourceDataset “C:\input\NAV” – Path and folder name of the VPF archive to be translated. 
• DestDataset “C:\output” – Path and folder name of the output to be generated. 

MAPINFO_COORDSYS_STATEMENT – Optional parameter – The CoordSys Clause applied to 
resulting .TAB\.MIF\.MID file. The Universal Translator does not re-project data being translated into 
a different coordinate system\projection. It applies the CoordSys clause passed to the resulting 
.TAB\.MIF file, so make sure the CoordSys used is appropriate for the data being translated. If no 
CoordSys clause is passed, the output .TAB\.MIF file defaults to Non-Earth, meters. 

Note VPF data is typically created in Longitude\Latitude (WGS84). 
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Exporting Data Using the Command Line
This section provides details for exporting data from MapInfo Professional to other data formats. 

Exporting Data to DWG or DXF Format

Step 1) Generating the Mapping File

Imut.exe CFGenerate MAPINFO DWG "D:\MapInfo\Regions.tab" "C:\temp\mapping.fme" 
LOG_STANDARDOUT YES LOG_FILENAME "C:\temp\mutlog.txt" LOG_APPEND "NO" --
Dest_ATTR "autocad_attributes" --Dest_ATTRKIND "extended_entity_data" --Dest_REL 
"Release2000" 

Understanding the Mapping File Parameters

Imut.exe – Application name of the MapInfo Universal Translator. Assumes it is running from a DOS 
prompt, so the path to it should be set.

CFGenerate – Command that generates a semantic control file

MAPINFO – Input format is MapInfo .TAB. If the input file has a .MIF\.MID extension, then use 
“.MIF”.

DWG – Output format is AutoCAD DWG format. If an AutoCAD DXF format is needed use "DXF".

"D:\MapInfo\Regions.tab" – Path and filename of the input MapInfo .TAB or .MIF\.MID file.

"C:\Temp\mapping.fme" – Path and filename of the semantic control file – can be prefixed any 
name.

LOG_STANDARDOUT – Generates a text log file during the translation (Yes or No).

LOG_FILENAME – Path and filename of the logfile to be generated.

LOG_APPEND – Appends the results of the logfiles in subsequent translations – (Yes or No) – 
Default is No.

• Dest_ATTR "autocad_attributes" – Creates AutoCAD attributes in the output file. 
• Dest_ATTRKIND "extended_entity_data" – Creates extended entities in AutoCAD files. 
• Dest_REL "Release2000" – Release version of the AutoCAD file to be created.

Note The Dest_REL parameter may be any one of these: Release11, Release12, Release13, 
Release14, Release2000, or Release2004.

*** AutoCAD Release 2002 format is same as Release 2000, and AutoCAD Release 2005 and 2006 
is same as Release 2004. 

Step 2) Running the Mapping File to Perform the Translation

Imut.exe “C:\Temp\mapping.fme” SourceDataset "D:\MapInfo\Regions.tab" --DestDataset 
“C:\temp\output.dwg” --_ATTRKIND extended_entity_data --_REL Release2000 --_EXTENSION 
TAB --_BASENAME Regions --_FULLBASENAME Regions 
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Understanding the Translation Parameters

Imut.exe – Name of the MapInfo Universal Translator executable.

"C:\Temp\mapping.fme" – Path and filename of the semantic control file generated in step 1.

• SourceDataset “D:\MapInfo\Regions.tab” – Path and filename of the MapInfo .TAB file to be 
translated.

• DestDataset “C:\temp\output.dwg” – Path and folder name of the output AutoCAD file to be 
generated. 

• _ATTRKIND extended_entity_data – Creates the extended entities in AutoCAD files. 
• _REL Release2000 – Creates a release 2000 AutoCAD file. See notes above on valid release 

versions. 
• _EXTENSION TAB – Input format extension (TAB or .MIF only). 
• _BASENAME – Name of the output file to be generated. Can be the same as input filename. 
• _FULLBASENAME – Can be the same as input filename

*** MapInfo CoordSys is not needed because the CoordSys is read directly from .TAB or .MIF file.

Exporting Data to the E00 Format 

Step 1) Generating the Mapping File

Imut.exe CFGenerate MAPINFO E00 "D:\MapInfo\Regions.tab" "C:\Temp\Mapping.fme" 
LOG_STANDARDOUT YES LOG_FILENAME "C:\Temp\mutlog.txt" LOG_APPEND "NO" --
Dest_PRECISION "Double" --Dest_COMPRESSION "NONE" 

Understanding the Mapping File Parameters

Imut.exe – Application name of the MapInfo Universal Translator. Assumes it is running from a DOS 
prompt, so the path to it should be set. 

CFGenerate – Command that generates a semantic control file

MAPINFO – Input format is MapInfo .TAB. If the input format is .MIF\.MID, then use “.MIF”. 

E00 – Output format is the ArcInfo Export format. 

"D:\MapInfo\Regions.tab" – Path and filename of the input MapInfo .TAB or .MIF\.MID file.

"C:\Temp\mapping.fme" – Path and filename of the semantic control file. Can be prefixed by any 
name.

LOG_STANDARDOUT – Generates a text log file during the translation (Yes or No). 

LOG_FILENAME – Path and filename of the logfile to be generated. 

LOG_APPEND – Appends the results of logfiles in subsequent translations – (Yes or No) – Default 
is No. 

Dest_PRECISION – Precision of the .E00 file produced, may be "Single" or "Double" – Default is 
"Double". 

Dest_COMPRESSION – Compression of the .E00 file - can be "FULL", "PARTIAL", or "NONE". 
Default is “NONE”. 
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Step 2) Running the Mapping File to Perform the Translation

Imut.exe "C:\Temp\mapping.fme" --SourceDataset "D:\MapInfo\Regions.tab" --DestDataset 
“C:\Temp\output” --_PRECISION Double --_COMPRESSION NONE --_EXTENSION TAB --
_BASENAME Regions --_FULLBASENAME Regions

Understanding the Translation Parameters

Imut.exe – Name of the MapInfo Universal Translator executable.

"C:\TEMP\MAPPING.FME" – Path and filename of the semantic control file generated in step 1.

SourceDataset "D:\MapInfo\Regions.tab" – Path and filename of the MapInfo .TAB file to be 
translated.

DestDataset “C:\Temp\output” – Path and folder name of the output .E00 file to be generated. 

• _PRECISION – Internal precision of the export file, can be “Single” or “Double”. Default is 
“Double”. 

• _COMPRESSION – Compression factor of the resulting .E00 file, can be "FULL", "PARTIAL", or 
"NONE". Default is “NONE”. 

• _EXTENSION – Input extension set to MapInfo .TAB. If the input extension is .MIF\.MID use 
“.MIF”

• _BASENAME – Name of the output file to be generated – can be the same as input filename
• _FULLBASENAME – Can be same as the input filename

*** MapInfo CoordSys is not needed - The CoordSys is read directly from .TAB or .MIF file.

Exporting Data to a Shapefile Format 

Step 1) Generating the Mapping File

Imut.exe CFGenerate MAPINFO SHAPE "D:\MapInfo\Regions.tab" "C:\Temp\Mapping.fme" 
LOG_STANDARDOUT YES LOG_FILEN

Understanding the Mapping File Parameters

Imut.exe – Application name of the MapInfo Universal Translator. Assumes it is running from the 
DOS prompt, so path to it should be set. 

CFGenerate – Command that generates a semantic control file

MAPINFO – Input format is MapInfo .TAB. If the input format is .MIF\.MID, then use “.MIF”. 

SHAPE – Output format is the ESRI Shapefile format. 

"D:\MapInfo\Regions.tab" – Path and filename of the input MapInfo .TAB or .MIF\.MID file.

"C:\Temp\mapping.fme" – Path and filename of the semantic control file – can be prefixed any 
filename. 

LOG_STANDARDOUT – Generates a text log file during the translation (Yes or No). 

LOG_FILENAME – Path and filename of the logfile to be generated. 
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LOG_APPEND – Appends the results of the logfiles in subsequent translations – (Yes or No), 
Default is No. 

Step 2) Running the Mapping File to Perform the Translation

Imut.exe "C:\Temp\mapping.fme" --HOMOGENOUS_GEOMETRY yes --_SHAPE_FILE_TYPE 2d --
SourceDataset "D:\MapInfo\Regions.tab" --DestDataset “C:\Temp\output” --_EXTENSION TAB --
_BASENAME Regions --_FULLBASENAME Regions 

Understanding the Translation Parameters

Imut.exe – Name of the MapInfo Universal Translator executable.

"C:\Temp\mapping.fme" – Path and filename of the semantic control file generated in step 1.

HOMOGENOUS_GEOMETRY – Sets the homogenous geometry setting to Yes – Default. (Can be 
Yes or No). MapInfo .TAB\.MIF files can have mixed object types whereas Shapefiles cannot. 
Setting this option to Yes creates a separate Shapefile containing each supported different object 
type found in .TAB file. 

_SHAPE_FILE_TYPE – Sets the Shapefile type to a 2D, which is the Default. Can also be "2dm" (2 
Dimensional with measures) or "3dm" (3 Dimensional with measures). 

SourceDataset "D:\MapInfo\Regions.tab" – Path and filename of the MapInfo .TAB file to be 
translated.

DestDataset “C:\Temp\output” – Path and folder name of the output .E00 file to be generated. 

• _EXTENSION – Input extension set to MapInfo .TAB. If the input file is in .MIF\.MID format, use 
“.MIF”

• _BASENAME – Name of the output file to be generated – can be the same as input filename
• _FULLBASENAME – Can be the same as input filename

*** MapInfo CoordSys is not needed because the coordinate system is read directly from the .TAB or 
.MIF file.

Exporting Data to the DGN Format 

Step 1) Generating the Mapping File

Imut.exe CFGenerate MAPINFO IGDS "D:\MapInfo\cy.tab” "C:\Temp\mapping.fme" 
LOG_STANDARDOUT YES LOG_STANDARDOUT YES LOG_FILENAME "C:\Temp\mutlog.txt" 
LOG_APPEND "NO" --Dest_TYPE3 "yes" --Dest_OUT_UNITS "IGDS_MASTER_UNITS" --
Dest_SEED "C:\Program Files\MapInfo\Professional\Ut\design\seed2d_m_v8.dgn" 

Understanding the Mapping File Parameters

Imut.exe – Application name of the MapInfo Universal Translator. Assumes it is running from a DOS 
prompt, so the path to it should be set. 

CFGenerate – Command that generates the semantic control file

MAPINFO – Input format is MapInfo .TAB. If the input format is .MIF\.MID, then use “.MIF”. 
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IGDS – Output format is MicroStation Design (DGN) file format. 

"D:\MapInfo\Regions.tab" – Path and filename of the input MapInfo .TAB or .MIF\.MID file.

"C:\Temp\mapping.fme" – Path and filename of the semantic control file – can be prefixed with any 
filename. 

LOG_STANDARDOUT – Generates a text log file during the translation (Yes or No). 

LOG_FILENAME – Path and filename of the logfile to be generated. 

LOG_APPEND – Appends the results of logfiles in subsequent translations – (Yes or No), Default is 
No. 

• Dest_TYPE3 – Allows type 3 elements to be created for 2 point lines (Yes or No), Default is Yes.
• Dest_OUT_UNITS – How the Universal Translator treats resulting coordinates in a Design file. 

Valid values are: 

• IGDS_MASTER_UNITS – Coordinates are treated as Master Units by default. 
• IGDS_SUB_UNITS – Coordinates are treated as Sub Units. 
• IGDS_UORS – Coordinates are treated as UORs. 
• Dest_SEED – Path and filename of the seed file used by the Universal Translator

Note The MapInfo Universal Translator uses the seed2d_m_v8.dgn seed file set by default to 
output MicroStation version 8 DGN files. If MicroStation version 7 DGN files are needed, set 
the seed file to use "seed2d_m.dgn". To create output using other seed files, look in the 
\design folder supplied by SAFE. However, Pitney Bowes Business Insight has not tested 
these other files so the results are unknown and unsupported. Contact SAFE for any issues 
arising out of their use. 

The MapInfo Universal Translator is shipped with the following MicroStation Seed files listed in 
\UT\design folder: 

• bcutm3d.dgn
• bcutm2d.dgn
• seed2d_ft.dgn
• seed2d_ft_v8.dgn
• seed2d_m_v8.dgn
• seed2d_m.dgn
• seed3d_ft.dgn
• seed3d_ft_v8.dgn
• seed3d_m.dgn
• seed3d_m_v8.dgn
• seed_ll.dgn. 

Step 2) Running the Mapping File to Perform the Translation

Imut.exe "C:\Temp\mapping.fme" – SourceDataset "D:\MapInfo\Regions.tab" – DestDataset 
“C:\Temp\output.dgn” --_TYPE3 YES 

• _OUT_UNITS IGDS_MASTER_UNITS – _SEED “C:\Program 
Files\MapInfo\Professional\Ut\design\seed2d_m_v8.dgn”

• _EXTENSION .TAB – _BASENAME Regions --_FULLBASENAME Regions 
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Understanding the Translation Parameters

Imut.exe – Name of the MapInfo Universal Translator executable. 

"C:\Temp\mapping.fme" – Path and filename of the semantic control file generated in step 1. 

SourceDataset "D:\MapInfo\Regions.tab" – Path and filename of the MapInfo .TAB file to be 
translated.

DestDataset “C:\Temp\output.dgn” – Path and filename of the output DGN file to be generated. 

• _TYPE3 – Allows type 3 elements to be created for 2 point lines (Yes or No), Default is Yes. 
• _OUT_UNITS – How the Universal Translator handles output DGN file units – Default is 

IGDS_MASTER_UNITS. See Dest_OUT_UNITS parameter in step 1. 
• _SEED – Path and filename of the seed file used by the Universal Translator. See Note for 

Dest_SEED parameter in step 1. 
• _EXTENSION – Input extension set to MapInfo .TAB. If the input extension is .MIF\.MID use 

“.MIF” 
• _BASENAME – Name of the output file to be generated – can be the same as input filename
• _FULLBASENAME – Can be the same as the input filename

*** MapInfo CoordSys is not needed because the coordinate system is read directly from .TAB or 
.MIF file. 
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